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1.Introduction

This document describes how to use the Cat-M "Module" board, from boot to data traffic.

This document targets engineers who will need to use the Cat-M Module board for test activities and
demos.

2.Board overview

The main interfaces and buttons are described in the picture below.
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NOTE : A USB to Serial Adapter will be required to communicate with the Module
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3.Board boot up
3.1. MFW

MFW is based on default.ELF file.

Note : That currently the FW is to be pushed from the Laptop and hence requires a dedicated Laptop per
UE to be used at all times. Bootup procedure below needs to be performed everytime the UE is USB
Powered down or Reset is performed.

3.2. BAT file for FW flashing

Please contact your Sequans POC for Batch file to Flash the UE & Latest FW

Firmware file (*.elf) should be renamed to default.elf & be placed under
SON_CATM_DM_STP_V0.3\SQN_FW _Load\Firmwares ( Please unzip the Batchfile to get this location.
Note this folder can be placed & run from anywhere on your PC, however it is important that *.elf file be
placed inside the Firmwares folder)

Note : Firmware file & Bootloader both are both in *.elf but can be differentiated by size.
Firmware file is approximately 3+ megabytes while the Bootrom will be approximately 1.5 megabytes

3.3. Bootup

1. Connect USB cable on the laptop to power up. Serial Ports will appear as you connect them to
different UART ports.

2. Use putty or teraterm to open UE console through UART2 with the baud rate 115200

3. On UE press on the Reset button to have UE loading the bootrom and to be able to load the
firmware

4. Copy your *.elf into the folder "SQN_FW _Load/Firmwares" with the name "default.elf"

5. Modify the "load_SQN_CatM_Fw.bat" script so as to use your correct COM port Number instead
of the preconfigured "COMA45" & set the Baud rate to 921600

6. Run the "load_SQN_CatM_Fw.bat" script

7. When the FW finish to load with 100%.

8. Now you can start your DM

9. Let's configure the DM if it was not done

10. DM->File->Preferences-> the window "Configuration" will open

11. Tick "enable UART"; then type correct COMM port corresponding to UARTO in the port name,
use baud rate 921600 instead of 115200 on the baudrate section

12. Click on OK. Using the UARTO serial port UE can now be seen connected on the DM.
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3.4. Bootloader Update

To check the current Bootrom Version Log into UE through console Port & The first line displays the
current version of Bootrom.

7

COM17 - Tera Term VT Current Bootrom = B X

\/ H
Frm— = version
Control Window Hely

File Edit Setup

ANNRNNARABAA]1 RBGerbhil 11.40325998 ’5.08.8.08 [2599801°
A000BBNA4]1 Reset cause ’EXT’ (real ’EXT’ " (LuucwdG : ’8’)> [rawRst ’OxB0000001°

regConf ig BxEC?7E34AFEF1

Running sector Bx1C848000800

bhoot: Current flash, timeout 18688, proto thp

[SFFF1 Error: Wrong magic

bhoot: Switched to uartl, timeout 680688, proto at

uart: using uartl with baudrate 9221600

[AT] Info: Forcing bhaudrate to 1152608 for AT negociation

Steps to update the Bootrom:

1. Connect UE USB cable on the laptop. Serial Ports will appear as you connect them to different
UART ports.

2. Use putty or teraterm to open UE console through UART2 with the baud rate 115200 and keep it

open all the while.

On UE press on the Reset button to have UE load the bootrom and to see the current version.

4. Copy your *.elf into the folder "SQN_FW _Load/Firmwares" with the name "default.elf" . Modify the
"load_SQN_CatM_Fw.bat" script so as to use your correct COMM port Number instead of the
preconfigured "COM45" & set the Baud rate to 921600

5. Runthe "load_SQN_CatM_Fw.bat" script

6. When the FW finish to load with 100%.

7. Go back to already open console port and press Enter. Mtools dedicated application text will
appear on screen.

8. To upgrade the Bootrom use the following commands.

AT ( Press Enter)
AT+SMBB=0,"DROP" ( Press Enter)

9. Bootrom is updated when console port returns “OK”. Reset the UE Manually or use AT*Reset &

from next boot up updated bootrom will be used.

w

See below image highlighting the above steps.
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— Al

COM17 - Tera Term VT S
File Edit Setup Control Window Help

5.0.0.8 [26014]1 by robot-soft at 2016
Wait for LPU to boot ...
SLO started

value = 1 = Bx1
5 AT +SMBB=@, "DROP"

[ERROR
¢ AT+SMBB=@."DROP"

OK
at“RESET
[ABAABAABAA]1 RBGerhil 11.4026014 ’'5.8.0.8 [26014]1°
[BABABAAAA4]1 Reset cause ’SW’ (real ’SW’ > <(hootWDG : ’@’> [rawRst ’BxB0000064° 1
[ABAABAAB11 ] regConfig BxEC?E34AFE1
[ABAABAAA14] Running sector Bx1CH8AHAA
[BABABABA18]1 boot: Current flash, timeout 10808, proto thp
[ABABBARB23]1 [SFFF1 Error: UWrong magic
[BABABABA26 1 boot: Switched to uartl, timeout 680BB. proto at
[ABAABAAA32 ] uart: using uwartl with baudrate 9221600
[060BBRBB37]1 [AT] Info: Forcing baudrate to 115208 for AT negociation

Please Note : Currently Reverting back to Older Bootrom is not compatible.
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4.DM connection

Please contact Sequans POC for latest Version of DM tool.

4.1. Start DM

1. Click on “4G Debug & Monitoring tool”; Sequans DM window shall be displayed as below:

#4 Sequans DM l = _I—J&

File Reset Views Dashboards Export Tools Help

| Mode:  Live events

User record control

L& | &) ] Basename: EEE——— -
Load cfg Start

— Backaround recording status

) Impact on UE Transparent

onnection status

Main Connected

Sequansd / Enabled event gty 45 (+13 when recording)

—

Serial port status

Buffer fill level 0%

ACM  Disabled Covered period last 1 minutes
GPS  Disabled

| [UE events] Bitrate: 0 kh/s Evt freq: 0 Hz Motif freq: 0 Hz

2. If not, make sure “File->Offline Mode” is untick.
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4.2.

Activate light events

1. Click on “Views->Record config”

~User record advanced configuration

Do nothing special = | when user record size above Fl@ MB

I™ Split user record on disconnection

~Enabled events (10)

ImpactonUE Transparent

Quantity Event name Activation lo¢ 4

catlisg Added when re
CLI External

CLI External

CLI Ims

CLI Ims

CLI Omadm
CLI Omadn

CLI Secuansd
CLI Secuansd
CLI Ue

CLI Ue

cli-external-out
cli-ims-in

cli-omadn-in
cli-omadn-out

enm-conn-fsm

hp-cat-fsm
hp-main-fsm
hp-sns-no-fsm

hp-usin-fsm
11p-cinr0
11p-cinrl
11n-rhet

DO 00000000000 OoEOCOOOOOOOooOo

Clearall

Expandall | Collapseall

Covered groups: Base,
LTE-PHY-DL, LTE-RRC, cli,
fsm, lte, ul-link

Covered events: llp-cinr0,
11p-cinrl, 11p-dl-ack,

B M

B B dHink

B Mfsm

B [gps

B Blog

8 [JLTE-MAC
B [¥]LTE-PHY-DL
@ [JLTE-PHY-UL
B [LTERRC

B Mte

8 [Ortogs

B [ sniff

B B traffic

8 [ ublink

B [Jzsp0

B Ozspt

Add base events

User recording config import/export

~Scripts and log configuration

UE script called just after start of recording | <Custom>

g

UE script called just before end of recording | <Custom> ﬂ Ag;i' |> ‘

UE log configuration called just after start of recording: Aoply
‘ Now

| kid

IMS log configuration called just after start of recording: Aooly >
Tov

OMADM log confiquration called just after start of recording:  app1y D
e ¥

Sequansd log configuration called just after start of recording:

[ Background recording ‘

2. Click on “Add base events” this will enable basic LTE events, Add specific events if required.
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4.3. Activate and stop DM logs

1. Before performing the test, activate DM logs by clicking on “Start” on “Sequans DM” window.

[ 2= Sequans DM l'=' | ' \&I

File Reset Views Dashboards Export Tools Help

‘ Mode:  Live events

— User record control

— Connection status — Background recording status

Main Connected Impact on UE Transparent

Sequansd Enabled event gty 45 (+14 when recording)
— Serial port status Buffer fill level 0%

ACM  Disabled Covered period last 1 minutes

GP5  Disabled

[UE events] Bitrate: 0 kb/s Evtfreq: 0Hz Motif freq: 0 Hz

2. Atthe end of your test, stop DM logs by clicking on same button, then click on “Cancel”. DM logs
are located at “Basename” path

4.4. Power up & Power Down the UE

1. To power up the UE, type “poweron” then press Enter on “CLI for UE” window.
2. To power off the UE, type “poweroff’ then press Enter on “CLI for UE” window.

Please run the command “addscanfreq 13 5230” before running any test in “CLI for UE” window
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5.Establish Data Connection to PC

5.1.

Open the device manager, click on Action—Add legacy hardware

Setup the Modem & Baud Rate

= Device Mansger
File | Acteon | View Help

‘a3 E

Sran for hardwans Chamges

==

Ldd legacy hardware

Help

o Disk drives

By Display adaptens

e DYDYCD-ROM drives

8% Human Interface Devices

g IDE ATASATAPL comtrallen

= Keyboands

ﬂ Mice amd other pointing deveces
I_‘- Meanan

& Metwork adspters

5 Pors (COM & LPT)

B precesson

& Sound, video and game controllers
{8 System devices

| ] LUrrodriad Senal Bus cantrolers

fudd & begacy [(mon Plug and Play] device to the computer,
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https://s3lte.sequans.com/lib/exe/detail.php?id=solutions:high_speed_ppp_windows&media=solutions:1.png

Click on Next

a2 Devce Manager = =
File View Help
eomHml &

da-PC

Welcome to the Add Hardware Wizard

Thes wizard helps you install driver software to support older
devices that do not support Plug-and-Play and which are not
automatically recognezed by Windows.

You should only use this wizard # you are an advanced user or
you have been diected here by technical suppornt,

5o your hardware came with an installation (D, it is

recommended that you click Cancel to close this wizard
and use the manufacturer’s CO 1o install this hardware,

To contnue, click Next.

Select Install the hardware manually

"

=3 Device Manager
Fie‘emon View Help
% |miHmli&

.’a_hgf-nc

Add Hardware

The wizard can help you install other hardware

The wizard can search for other hardware and automatically install it for you. Or, if you
know exactly which haedware model you want to install, you can select & from a kst

What do you want the wizad te do?
Search for and nstall the hasdware automatically (Recommended)
@ Instell the hardware that [ manuelly select from o list (Advanced)

[cooox ][ Meex ] [ Conca

In the list, select Modem
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https://s3lte.sequans.com/lib/exe/detail.php?id=solutions:high_speed_ppp_windows&media=solutions:2.png
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24 Device Manager o3&

File [Action | View Help

L Ml 7 Boidk.
M _"“}’“ft, _
o

From the list bedow. select the type of hardware you are installing

¥ you do not see the hardware category you want, click Show All Devices.

Common hardware types:
Himaging devices o
" infrared devices
W 0 edia Center Extender
ElMemory technology driver ¥

T Multi-port serial adapters

& Network adapters

EJPCMCIA adapters

&F Portable Devices v

<Bock | Mee> | | Conce

Check Don't detect my modem

o= Device Manager E—
e [Acin) Ve i
&% Hm
oAbudefl
Install New Modem
Do you wart Windows to detect your maden?

Windows will now try o detect your modem. Befome
continuing. you should:

1. ¥ ihw modem i attached o your
computer, make sue & is bumed on

2. Gust any programa that may be using
he moden

Oick Neat when you ame ready 1o coninus

¥ Dont detect my modem; | wil select & from a kst

<Bace [ Net> | | Concel |

In the list, select Communications cable between two computers
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& Device Manager

[eTEls]
Fie [Action | View Help
& miHEm &
arahu:h-FC

" Add Hardware Witard

Install New Modem

s~ Select the manufactures snd model of your modem, If your modem i not ksted, or # you heve
waf  oninstalation dick, click Have Disk.

Meanufacturer Modets

{(Standard Modem Types) B Communications cabile between two compitern El

o Pacaliel cable between two computers
o' Standard 300 bps Modem
—o Standard 1200 bps Medem
Commdand YD bnn bl done
[y This driver & digitally signed. Have Dsk...

T2l me why driver signing i3 impotan

Select the COM port associated with the UART1 of the board (in this case, we use COM5)

22 Device Manager =N KR R <A
File [(Action ) View Help

e o B

Ao

Add Hardware Wizard

Install New Modem
Salact the potis) you want 10 install the mockem on

You have sclected the followng modem:

[Commurications catle between two computers

On which ports & you wanrt 1o netall 17

T Hpots
(¥ Selacted ports

COM3
Come

COms

Click on Finish
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29 Device Manager [Sl@l=
File Veew  Help
&= | ™ ol
4(@'1:::!5 ?( S 2
Add Hardware Wizard

Install New Modem
Modem nstallation & firished'

Your modem has been set Lp successfily

¥ you wart 10 change these sefiings, doublecick the
Phone and Modem Options icon in Control Panel, cick the
Modems tab, select thes modem. and then chck Propedies

Now in the device manager, under the Modem section, you can see the Communications cable between
two computers

—1g

)]

File Action View Melp
e D Bm e 288

4 @ huds-PC
& Batteries
& Computer
. Disk drives
B Display adapters
o DVD/CD-ROM drives
05 Human Interface Devices
<4 IDE ATA/ATAPI controllers
— Keyboards
A Mice and cther pointing devices
& Modems
1o Communications cable between twe computerss
& Monitors
& Network adapters
7 Ponts (COM & LPT)
B Processors
& Sound, video and game controllers
M Systern devices
9 Universal Serial Bus controlless

[N

Click right on it, and select Properties
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File Action Veew Help
=m0 Hm & &%b
g hudaPC

] a Bstteries

188 Compurter

b Dk drives

- Display adagters

b ekl DVDFCORROM droves

] lli Human Interface Devices

b g [DE ATA/ATAR] controllens

= Eeyboards
B n_ Bdice and other pointing devices
4 (5] Madems
el G icationy-==i~ - -
b ‘ Blanibars Update Driver Softwane...
» &F Metwork adapters Disable
b TF Ports (COM & LPT) Uninstall
¢ B Processors
b8y Sound, video and g3 Scan for hardware changes
b M System devces

b Universal Serial Bus ¢ Properties

Opens propery shest for the curent selection.

In the tab Modem list the baudrates for Maximum Port Speed, you will see that the maximum value is
115200.

R =]
e Adion View Hol
e=im| 0@

4 g8 huda-PC

8 Computer
> g Disk drives

&5 Display sdapters
- o3 DVD/CD-ROM drives

25 Human Interface Devid o L
.+ g IDE ATA/ATAPI contrd
> &= Keyboards

I Mice and cther peirtin Masmun Pod Speed
4 &5 Modems

il Comemnications 4 sao =

. & Menitors 300

& Network adspters ;fg

7 Ports (COM & LPT) Ol Corg 4800

. Processors 600
. % Scund, video and gam i

N Systern devices 57500
+ - § Unwversal Senal Bus co

Lok ]| Concw |

We want to make 921600 baudrate available. To do so we have to modify the base register.

Close the Properties window and start regedit as administrator
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Go into HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Contro\Class{4D36E96D-E325-11CE-
BFC1-08002BE1031810000 Check the AttachedTo field value matches the UART1 COM port. Here we
have highlighted an example of COM24.

= s
T

. ”
. e g e T

@ Registry Editor TRY E@ 1
File Edit View Favorites Help
). BackupRestore + | Name Type Data
4| Class _allﬂmm.m REG.GZ / t sef)
)b ATSBESL S EED B6C2000FA0S0  [aanacedto R &E
)l {091BCI7E-2352-4362-A539-10A6D8FF7596) [ R'EG_SZ il
: : gigﬁg 5F1/25CC 88F‘:3\F7E 285::[)0;;?3 ;: Ii386325}} J'-'l's} DCB REG_BINARY 1c 00 00 00 00 10 0e 00 15 20 00 00 00 00 0a 00 Oa .
i.> |, (2BE2SEB0-BCAA-L1E1-9A96-ETCT1887098) J’-'c'p} Default REG_BINARY 00100 00 00 00 00 00 00 00 00 00 00 00 00 00 00 10..
). (AMGESE-TBA-BI6 DAG-BEADIMGSH) || DevceType  REGBINARY (0
- BEFCOEG0-CAGS-11CF-B056-444553540000) Bbrverdate  REG.SZ 3-9-2000
b (3F966BDI-FAD4-AECS-991C-D32697385128) "-"} DriverDateData ~ REG_BINARY 0040 84 69 5a 89 bf 01
b~} {4116F60B-25B3-4662-B732-99A6111EDCOB} | ]DnverDesc REG_SZ Communications cable between two computers
by {43675D81-502A-4A82-9F84-B75F418C5DEA} lb]DnverVemon REG_SZ 6.1.7600.16385
b {4532C9EB-FEF9-43AC-83DA-DSDELFIAZBEF) b EnumPropPages.. REG_SZ modemuidll,ModemPropPagesProvider
b I, {4658EETE-FO50-11D1-B6BD-00C04FA3T2AT) ab lFriendlyName ~ REG_SZ Communications cable between two computers #2
b -} {48721B56-6795-11D2-B1A8-0080C72E74A2} j} REG BINARY A 3do07
B aCmon, O BT
b}, (4D36ES66-E325-11CE-BFC1-08002BEL0318) af}l”fsef""” — e ,
] {AD36E967-E325-11CE-BFC1-08002BE10318) 2blLoggingPath REG.SZ C\Windows\ModemLogs\ModemLog_Communica...
)} {4D36E968-E325-11CE-BFC1-08002BEL0318) AManufactrer  REG 57 (Gtandard ModemTypes)
»-J. {4D36E969-£325-11CE-BFC1-080028E10318) 2 MetchingDeviceld REG SZ pnpcd3l
b | {4D36E96A-E325-11CE-BFC1-08002BE10318) J‘-'«ﬂMammumPonSp REG_DWORD 0x000e1000 (921600)
b~ {4D36E96B-E325-11CE-BFC1-08002BE10318} @ ]Model REG_SZ Communications cable between two computers
) | {4D36E96C-E325-11CE-BFC1-08002BE10318} rJ PermanentGuid ~ REG_BINARY al845e599114dd43a92482139227 42 a7
4-| {4D36E96D-E325-11CE-BFC1-08002BE10318} Igg}PonSubGass REG_BINARY 02
b4 000 REG_BINARY 001000000 0000 0000100100 000000 00 00 00 00..
»-). 0001 ab|providerName ~ REG_SZ Microsoft
‘:-) o -*"} ResponseskeyNa.. REG_SZ Communications cable between two computers:(St..
\> : gggi |UINumber REG.DWORD 0+00000002 ()
>-J. 0005
>-J. 0006
b- ). 0007
>-). 0008
4}, 0009
— Y =,

Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Class\{4D36E96D-E325-11CE-BFC1-08002BE10318}\0009

Double click on Properties
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QRegistryEditor 2008

| g =E] X |

File Edit View Favorites Help

.f> | BackupRestore
4| Class

{0475BB51-5A02-4EE0-B36C-29040FAD2650}
{091BC97E-2352-4362-A539-10A6D8FF 7596}
{1264760F-ASC8-4BFE-B314-D56A7B44A362} D

“ || Name Type
35 Defaul) REG.SZ
0] AttachedTo REG.SZ
|ConfigDialog  REG_SZ
#|DCB REG_BINARY

Data

(value not set)

COM24

modemui.dll

1c 000000 00 10 0e 00 15 20 00 00 00 00 0a 00 0a ..

)

I

)

J

| {34446E8E-3784-4B16-9DA6-BEA2
| {36FCIE60-C465-11CF-8056-444553
| {3F966BD9-FA04-4EC5-991C-D3269
| {4116F60B-25B3-4662-B732-99A611
| {43675D81-502A-4A82-9F84-B75F4 1
| {4532C9EB-FEF9-43AC-83DA-DSDE!
| {4658EE7E-F050-11D1-B6BD-00C04)
| 48721856-6795-11D2-B1A8-0080C7
| {49CE6ACS-6F86-11D2-B1ES-0080CH!
| {4D36E965-E325-11CE-BFC1-080028}1
| {4D36E966-E325-11CE-BFC1-080028}!
| {4D36E967-E325-11CE-BFC1-080028}!
| {4D36E968-E325-11CE-BFC1-080028)
| {4D36E969-E325-11CE-BFC1-080028)
| {4D36E96A-E325-11CE-BFC1-080028
| {4D36E96B-E325-11CE-BFC1-08002B
)
I

0000
0001
0002
0003
0004
0005
0006
0007
0008
0009
X | AllUserSettings

b

{25DBCES1-6C8F-4A72-8A6D-B54(pamcaacy
{2BE28EB0-BC4A-11E1-9A96-E7CT6] Edit Binary Value L"{

-

{4D36E96C-E325-11CE-BFC1-080028\ s
{4D36E96D-E325-11CE-BFC1-08002BE10318}

Value name:

Properties

Value data:

0000 00 00 0O 00 00 00 0O 00
0008 00 00 0O 00 00 00 00 OO ........
0010 00 00 0O 00 30 00 00 0O ....0...

0018 [T 00 00 2 01 00 M. .A..
0020

WPortSubClass  REG_BINARY
4 Properties REG_BINARY
providerName  REG_SZ
é}ﬂResponsesKeyNa... REG_SZ
4 UNumber REG_DWORD

v

0 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 10..
0
-9-2000

40 8469 52 89 bf 01
I(t):mmunications cable between two computers
1.7600.16385
odemui.dll, ModemPropPagesProvider

mmunications cable between two computers #2
A3doo7

£x000e1000 (921600)

mmunications cable between two computers
845599114 dd 432924 8213922742 a7

02

0000 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00...
Microsoft

Communications cable between two computers:(St..
0x00000002 (2)

Computer\HKEY_LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\Class\{4D36E96D-E325-11CE-BFC1-08002BE10318}\0009

Find the first occurence of 00 C2 01 00 and change it into 00 10 OE 00
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@RegistryEditor T

File Edit View Favorites Help

{}‘l BackupRestore 4 || Name Type Data
4-). Class a6 (Default) REG.SZ (value not set)
b-| {04758B51-5A02-4EE0-B36C-29040FAD2650} BtachedTo  REG.S7 COM4
3 sy} o
T e
¢ ot i T REG_BINARY
- e — wncs £G_BI 1c.00 00 00 00 10 e 00 15 20 00 00 00 00 0a 00 0a
: 4| Default 00 00,00 00 00 00 00 00 00 00 00 00 00 00 00 00 10..

2BE28EBO-BC4A-11E1-9A%6-E7CT7¢

)
)
J
J
4
)
J
J
)
)
J
by
)
)
J
J
)
)
J
J
)
)
J

34446E8E-37B4-4B16-9DA6-BEA,

Edit Binary Value

{4D36E96B-E325-11CE-BFC1-08004
{4D36E96C-E325-11CE-BFC1-08002)
{4D36E96D-E325-11CE-BFC1-0800:

0008

00 00 00 0O 0O 0O 0O 0O

00

). BEFCORSD-CAgS-LICFB0se-4msef [ j-

b (3F966BDI-FAQ4-4EC5-991C-D32 : 00408469 52 89 bf 01

b} (A116F608-25B3-4662-8732-90A6] | Propertes Communications cable between two computers
). (43675D8L-502A-4A82-0F64-BTSFA | Value date: 6.1.7600.16385

b {4532C9EB-FEF9-43AC-83DA-D5DE | (0000 00 00 00 00 00 00 00 00 ........ modemuidll ModemPropPagesProvider

Communications cable between two computers
al845e599114dd 4329248213 922742 a7
02

. {4658EETE-F00-11D1-B6BD-00COH 0010 00 00 00 00 30 00 00 00 0 Communications cable between two computers #2
b-). (48721856-6795-1102-81A8-0080¢ | [oo1s oo 00 00 2 01 00 M. .A.. 434007

b- ). {49CEGAC8-6F86-1102-B1ES-0080()| (0020 Y

b ). {4D36E965-E325-11CE-BFC1-08002) o

b-). {4D36E966-E325-11CE-BFC1-08002) j :

N {4D36E967-E325-11CE-BFC1-0800) C\Windows\ModemLogs\ModemLog_Communica..
). 4D36E968-E325-11CE-BFC1-0800] (Standard Modem Types)

b- ). {AD36E969-E325-11CE-BFC1-08002) pnpc031

>~ ). {4D36E96A-E325-11CE-BFC1-0800| 0x000e1000 (921600)

>+ 0000 ) Properties REG_BINARY 00,00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00..
b4 0001 :ﬁ]ProviderName REG_SZ Microsoft
?'l 0002 :‘_E}ResponsesKeyNa... REG.SZ Communications cable between two computers:(St..
:>-l anta S)UINumber REG_DWORD (0x00000002 (2)
b1 0004 :
b1 0005
b-). 0006
b1 0007
b~ 0008
4-|. 0009
vvvvvv | AllUserSettings v

Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Class\{4D36E96D-E325-11CE-BFC1-08002BE103181\0009

Close regedit, return in the device manager and re-open the Properties window of Communications cable
between two computers
Select 921600 as maximum baudrate
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‘Dﬁicelﬂuugu
File. Action View Help

=m0 8

4.3 huda-PC
5 ‘ Batteries
» {& Computer
b Dk drives
+ W5, Display adepters
» i} DVD/CD-ROM drwves
- 0% Human Intesface Devig
» <@ IDE ATA/ATAPI contra
» == Keyboards
» 14 Mice and other pointir
« &) Modems
) Communications ¢
b ‘ Manitors
&¥ Network sdapters
"7 Ports (COM & LPT)
o B Processoes
» 4% Sound, video and gam
(B System devices
, - § Universal Sesial Bus col

P L T e e e
Pot  COMS

[ ok ]| cConce !

Open the Network and sharing center

L = o
= =] .

=l _3
@v% <« Networ... » Network and Sharing Center - ] 4y II Search Controi Panef ol
Control Panel Home - - » . . b
View your basic network information and set up connections
Change adapter settings * A O See full map
Change advanced sharing 52
g || «& HUDA-PC Network Internet
{This computer)
View your active networks Connect or disconnect
Access type: Internet
Network HomeGroup: Joined
s | Home network Connections: § Local Area
Connection
Change your networking settings
E- Set up a new connection or network
Set up 2 wireless, broadband, dial-up, ad hoc, or VPN connection; or set
up a router or access point.
? Connect to a network
Connect or reconnect to a wireless, wired, dial-up, or VPN network
connection.
" Choose homegroup and shanng options
Access files and printers located on other network computers, or
change sharing settings.
@ Troubleshoot problems
Diagnose and repasr network problems, or get troubleshooting
information.
See alve
HomeGroup
Internet Options
Windows Firewall

Click on Set up a new connection or network

Select Set up a dial-up connection
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~4-,'. =

Choose a connection option

Connect to the Intemet
Set up a wireless, broadband, or dial-up connection to the Internet,

; Set up 2 new network
Configure a new router or access point.

Connectto a
Set up a dial-up or VPN cannection to your workplace

Type the information from your Internet service provider (ISP)

Dial-up phone number: 1234 Dialing Rules
User name: [Name your ISP gave you]
Password: [Password your ISP gave you]
[} Show characters
[7J Remember this password
Gonniin pam Dial-up Connection

& [ Allow other people to use this connection
This option allows anyone with access to this computer to use this connection.

Idon't have an ISP

When the dialing window appear, click on Skip
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Connecting to Dial-up Connection...

Click on Close on the next window

The connection is ready for use

Return in the Network and sharing center and click on Change adapter settings on the top left
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& = F <« Networ » Network and Sharing Center ~ 14 |[ =

Control Panel Home - - - - 2
View your basic network information and set up connections

Change adapter settings \& _, O See full map

EBSOgE Svanced st «& HUDA-PC Network Internet

settings
(This computer)
View your active networks Connect or dis< nect
Access type: Internet
Network HomeGroup: Joined
- » Home network Connections: ¥
CThange your networking settings
< Set up 2 new connection or network
=
Set up 2 wireless, broadband, dial-up,. ad hoc, or VPN connection; or set
up 3 router or access point.
Mpe Connectto a network
Connect or reconnect to a wireless, wired, dial-up, or VPN network
connection.
@y Choosehomegroup and shaning options
Access files and printers located on other network computers, or
change sharing settings.
==% Troubleshoot problems
=
Diagnose and repair network problems, or get troubleshooting
informatson.
HomeGroup

internet Options

Windows Firewall

Click right on the Dial-up Connection and click on Properties

@\J" B <« Network an... » Network Connections » ~ | 9 il Seorc ork Conme =)
Orgenize ~ Start this connection Rename this connection » e -
(‘ ¥4 Dial-up Connection ; Local Area Connection
-~ -~ Ne
— Disconnected Network

RO/1000 MT Desk

(il Connect ' R) §

Stats

Cancel as Default Connection
Create Copy

Create Shortcut
¥ Delete
% Rename

¥ Properties

In the Options tab, uncheck Prompt for name and password, certificate, etc. and Prompt for a phone
number
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- 1 pere : N ¢
\ v o« Network and Intemet » Network Connections »
Gk

Organize » Start this connection Rename thes connection Delete this connection

L' ¥ Dial-up Connection
= _ Disconnected

~
“ Communications ¢

-

or

Dhsing cptions
¥| Display progress while cormacting
] Prompt for name and password, catficate, sic
Inchude Vindows logon doman
Prompt for phone number

Rediaing options
Redal atempts 3
Time betwesn redal attempts [1 minte
ide sme before hanging up 20 minses
ide tveshold

Radal f ine is droppad

[ PPP Settings

Cox

CRIDC

~Tos |[ Search e

»

IWatchinaDesced eG S2

onocU3l

Once the UE is ATTCHED to the Network, Type below commands to establish PPP connection to the
Laptop

Connect to the UART1 port( Used to load the FW) with baud rate of 921600 & then

AT ( Press Enter)

AT+CGDATA="PPP",1,1

Once you see Connect message close the window and proceed to Next Step.

Note : It is important to close the window as otherwise the port remains occupied and PPP connections is
not established.
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Click right on the Dial-up Connection and select Connect

S S |
- = | & <« Network and Internet » Network Connections » ~ | <9 X
Organize ~ Start this connection Renarme thi Delete this connection - s "
B . Disi-up Connection B Local Area Connection
2 Connect L

Cancel as Default Connection
Create Copy

Create Shortcut
i Delete

' Rename

s Properties

A dialog window opens, passes quickly the connection steps until it shows Connected for a few seconds,

then it closes itself.

The console of the board shows that PPP connection is established and shows the local and remote IP

adresses.

Connecting to Dial-up Connection...

L Connsded
o]
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